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Introduction

Introduction
Using these Materials

The QuarkEd for QuarkXPress lessons contain a minimum of text so you
can concentrate on doing rather than on reading. However, enough infor-
mation is included so that after you complete the lessons, you can try out
the exercises on your own.

Each lesson starts with a new file that includes all the necessary elements
from the previous lessons, so if you delete or change elements in one
lesson, you won’t miss anything in another lesson.

v



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Introduction

Getting Started

Getting Started

Every QuarkEd lesson includes a Lesson Guide and the sample electronic files
required to complete the lessons.

About the modules

If you’re new to QuarkXPress, start with Module 1: QuarkXPress Fundamentals.
This module contains four lessons that give you an opportunity to work with
text, pictures, and other QuarkXPress elements as you complete a simple docu-
ment and prepare it for printing. When you finish these lessons, you’ll have
covered all the information you need to create your own QuarkXPress project.

If you’ve used QuarkXPress before you may want to proceed to Module 2:
QuarkXPress Essentials. This module contains eight lessons that teach you how
to construct documents, work with color, format text with style sheets, fine-
tune typography, combine type and graphics, prepare documents for high-
resolution printing, and other topics. The lessons in Module 1 will help you
work more efficiently and productively in QuarkXPress.

If you are already proficient in QuarkXPress — or have completed Modules 1
and 2 — you may want to explore Module 3: Advanced Techniques. This module
contains six lessons that teach you how to use QuarkXPress as an illustration
tool, how to increase your productivity in QuarkXPress, and how to publish long
documents using the books, lists (table of contents), and indexing features.

About the lessons

The modules are divided into individual lessons, which build on information
learned in previous lessons. However, you do not need to complete all the
lessons. You may choose the lessons relevant to you and skip others. 

Each lesson is divided into two sections: “The Steps” and “The Details.” “The
Steps” section presents a series of tasks that make up the hands-on portion of a
lesson. Tasks don’t contain a lot of text, but provide the information you need
to complete a lesson and serve as a “how-to guide” after class. Each section of
steps ends with a “Checkpoint” page that suggests various ways to check your
skills, and presents additional ideas for further exploration. 

“The Details” contain the reference section of a lesson. Included is in-depth
information related to topics covered in “The Steps.” This is a great place to
start when you want to learn more about a particular topic or feature. 
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Getting Started

Other reference books

Another source of information is the documentation that comes with the
QuarkXPress software. The documentation includes a complete user guide, A
Guide to QuarkXPress; a tutorial, A Preview to QuarkXPress; and various other
booklets and electronic files.

H Printing modules and lessons: The QuarkEd for QuarkXPress Lesson
Guides are in the form of Adobe Acrobat files. You can print a Lesson

Guide before you begin working on a lesson, or you can open the PDF file in
Adobe Acrobat Reader and switch back and forth between QuarkXPress and
Adobe Acrobat Reader.
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Conventions

Conventions

What’s ahead

Each lesson begins with a brief overview of what you’ll learn. When applicable,
a finished version of the lesson file is included so you can open it to see where
you’re heading.

Lessons and tasks

Lessons are made up of individual tasks that cover a concept, procedure, or
feature. Individual tasks are made up of a series of numbered steps that are
divided into two parts — the what you’ll do part includes minimal details in
bold type face; the how you’ll do it part lists specific details and tools you’ll
need to complete the step (in plain type face). What you’ll do appears on the
first line of a numbered step; how you’ll do it appears on subsequent lines.

For example:

.1 Copy the picture box on page 1: Using the Item tool e, click to select
the picture box containing the “Color Pastels.tif” picture file.

Choose Edit & Copy.

Menu paths

Menu paths are indicated by arrows &. For example, the following instruction
asks you to open the Print dialog box by choosing the Print command from
the File menu:

Choose File & Print to open the Print dialog box.

Information you enter

Information you need to type appears in a typewriter type font. For example:

Using the Content tool E, click to select the text box; then type color.

viii



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Introduction

Conventions

Screen captures and tables

Screen captures are often used to provide visual examples or avoid unnecessary
explanatory text. Tables sometimes accompany or replace screen captures so
you can quickly check settings as you perform a task. 

In the following example, you have a screen capture for a visual reference, along
with a table showing the exact settings you need to make:

Choose Item & Step and Repeat to open the Step and Repeat dialog box:

The Step and Repeat dialog box lets you specify the number of copies QuarkXPress
makes of an active item, and how far the copies are offset horizontally and vertically
from the original and each other.

Enter these settings, then click OK:

Field Setting

Repeat Count 3
Horizontal Offset 0 pt
Vertical Offset 50 pt

Tips, keyboard commands, and notes

The sidebar contains tips relating to a task, as well as keyboard commands used
on that particular page. 

Tips
Tips include information that’s helpful or useful, but may not directly affect your
performance of a task. Tips often provide background information or suggest an
easier or more efficient way to accomplish a particular function. 

For example:

H Moving the Tool palette: By default, the Tool palette appears to the left
of the document window, but it can be moved by dragging the shaded

bar at the top of the palette.
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Keyboard commands
Keyboard commands list a key or combination of keys that you can press to
perform a particular function without using your mouse. The keyboard
commands immediately follow each task’s instructions.

For example:

J Keyboard Commands for Mac OS: 

Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+P

J Keyboard Commands for Windows:

Print  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+P

When keyboard commands appear in text, they are listed with Mac OS
commands first, followed by Windows commands and separated by a slash.
For example:

To make the document window update as you scroll, press Option/ALT

while dragging the scroll box.

The following symbols are commonly used to represent particular keys on
Mac OS:

• Command key: C
• Option key: `
• Shift key: w
• Control key: ^

Notes
Notes appear in the main body of text because they contain information that
can have a direct impact on your understanding of a task or its outcome. 

For example:

G If you import a picture into a box that already contains a picture, the
existing picture will be replaced by the new one.

H Saving while performing lessons: Each lesson in QuarkEd directs you
to create or to open a file, then name and save it. Steps in the lessons do

not instruct you to save thereafter — you should save as often as you normally
would while working on a computer. This means save often.
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Setting Up

Setting Up

Before you begin working on a lesson, be sure QuarkXPress, the appropriate
fonts, and the necessary lesson files are on your machine. 

QuarkXPress software

There are a few things to check inside your QuarkXPress program folder before
getting started. 

First, locate the file called XPress Preferences. The XPress Preferences file stores
default settings that dictate how various QuarkXPress features work — and there-
fore may affect steps in the QuarkEd lessons. If you’re working with a new copy
of QuarkXPress, the preferences will contain the Quark-specified defaults and
you will not need to worry about it. If this is a working copy of QuarkXPress used
in a publishing environment, the XPress Preferences may contain hours worth of
modifications. If you suspect that is the case, place the file in a separate folder for
the duration of the lessons. When you launch QuarkXPress, it will create a new
“factory” preferences that you can use to complete the lessons. 

The second thing to check is the “XTension” folder within your QuarkXPress
folder. XTensions™ software expands the capabilities of QuarkXPress by adding
features, menu commands, tools, etc. Make sure the following files are in the
XTension folder: Cool Blends™, JPEG Import, LZW Import, XPress Tags Filter.
Check the “XTension Disabled” folder for any missing files.

Fonts

To simplify font issues, the Mac OS sample documents contain only Helvetica
and Times fonts; the Windows sample documents contain Arial and Times
New Roman fonts.
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Lesson files

If you intend to download several lessons, you may want to create a folder
on your hard disk for storing the lesson folders. We suggest that you create
a folder called “QuarkEd for QuarkXPress” and create folders within called
“Module 1,” “Module 2,” and “Module 3.” Each time you download a lesson,
move the resulting folder into the appropriate module folder.

H Launching QuarkXPress: It might be helpful to create an alias or
shortcut for QuarkXPress so you can use a desktop icon to easily

launch the program.

H Working with a demonstration version: If you do not own QuarkXPress,
download a demonstration version of the software that you can use to

complete the lessons. However, you cannot save files with the demonstration
version, so you should skip over those steps in the lessons.

xii
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1
The Concepts
What’s Ahead

QuarkXPress is electronic publishing software. You can use it to create any
kind of publication, from black-and-white business cards to multicolor
magazines. To use QuarkXPress effectively, you need to understand some
basic concepts. 

This lesson will introduce you to concepts and interface features that are
fundamental to QuarkXPress. To see the finished document, open the
QuarkXPress file called “Color Final.qxt” in the “Lesson 1” folder.
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Lesson 1: The Concepts

The Steps: Opening an Existing Document

Opening an Existing Document

In this task you’ll open a partially completed page from an article about color.
Later you’ll examine important concepts and interface conventions as you
complete the page.

J Keyboard Commands for Mac OS:

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+O

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+0 (zero)

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+S

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+`+S

J Keyboard Commands for Windows:

Open  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+O

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+0 (zero)

Save  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+S

Save as . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+S

.1 Launch QuarkXPress: If QuarkXPress isn’t running, locate the
QuarkXPress icon and double-click it.

.2 Display the Open dialog box: Choose File & Open.

The Open dialog box shows the QuarkXPress version that created a document and
the document type. 
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The Steps: Opening an Existing Document

.3 Open the “Color Begin.qxt” file: Open the “Module 1” folder, then
open the “Lesson 1” folder. Select the “Color Begin.qxt” template and

click Open. 

G If the Nonmatching Preferences dialog box displays, click Keep
Document Settings. If the Missing Fonts dialog box displays, click
Continue. A new document based on the template appears in the
document window.

.4 Change the document view: If you can’t see the entire document page
and the pasteboard surrounding it, choose View & Fit in Window. The

document page is centered in the document window.

The pasteboard surrounding each page or spread can be used to store QuarkXPress
elements. Items on the pasteboard, such as the dotted rectangle containing the
word “color,” won’t print unless they overlap a document page.

.5 Save the document in the Student Files folder: Choose File & Save as
to display the Save as dialog box. Locate and open the folder in which

you want to save the file.
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Lesson 1: The Concepts

The Steps: Opening an Existing Document

Enter a descriptive name for the file such as “My Color Doc.qxd.” (Use the
three-character extension “.qxd” in the name.) 

Verify that the Type is Document(s) and the Version is 4.0, then click Save.

H Opening templates: When you open a template, QuarkXPress creates a
new copy of the original document for you to work on. This lets you make

changes to the copy without affecting the original. (Therefore, all QuarkEd lesson
files are saved as templates.) If you want to apply changes to a template, simply
use the same name and replace the existing file.

H Fitting a spread in the document window: You can fit an entire spread
and the pasteboard in the document window by pressing Option/ALT

while choosing Fit in Window.

H Naming files: Adding the ”.qxd” extension to file names ensures that both
Mac OS and Windows will recognize the files as QuarkXPress documents.

(Windows adds extensions to file names automatically, but you can also enter
them manually as you would on Mac OS.) The “.qxt” extension identifies files as
QuarkXPress templates.
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The Steps: Examining the Tool Palette

Examining the Tool Palette

Often, you can use menu commands, keyboard commands, or palettes to
perform the same task. Palettes are movable windows that contain related
controls or tools. Two of the most frequently used QuarkXPress palettes are
the Measurements palette and the Tool palette. In this task you’ll examine
the Tool palette.

J Keyboard Commands for Mac OS: 

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Application Preferences  . . . . . . . . . . . . . . . . . . . . . . . .C+`+w+Y

J Keyboard Commands for Windows:

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Application Preferences  . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+Y

.1 Display the Tool palette: If the Tool palette isn’t open, choose View &
Show Tools.

Tools create and edit elements such as text boxes, picture boxes, lines, text paths,
text, and pictures. When you click a tool to select it, its icon is highlighted.
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The Steps: Examining the Tool Palette

.2 Open the Application Preferences dialog box and enable Tool Tips:
Choose Edit & Preferences & Application.

Click the Interactive tab.

In the lower right of the tab, locate the Show Tool Tips box and make sure it’s
checked. Click OK.

The Interactive tab lets you control many of the ways you interact with QuarkXPress.
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The Steps: Examining the Tool Palette

.3 Display tool names: Move the pointer over a tool in the Tool palette to
display its name. There may be a slight delay before the tool name appears.

Place the cursor over other tools to display their names. You’ll learn what each
tool does as you use it.

When the pointer is placed over a tool, its name displays whether or not the tool
is selected.

.4 Look at the “pop-out” tools: Click and hold one of the tools with a
small arrow in its upper right corner (for example, the Rectangle Text

Box tool T¶). 

Notice the additional tools. “The Details” section of this lesson explains how
you can customize the Tool palette by adding hidden tools or removing some
of the existing ones. 

H Moving the Tool palette: By default, the Tool palette appears to the left
of the document window, but it can be moved by dragging the shaded

bar at the top of the palette.

H Turning off Tool Tips: Once you become familiar with QuarkXPress, the
Tool Tips may get in your way. To turn the feature off, simply uncheck

Show Tool Tips in the Interactive tab of the Application Preferences dialog
box (Edit menu). 
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The Steps: Creating Guides

Creating Guides

Guides are nonprinting lines used to position items on a page. You specify
margin guides when you create a new document. For positioning page ele-
ments, you can drag ruler guides onto a document page from the rulers. In
this task you’ll create horizontal and vertical ruler guides.

J Keyboard Commands for Mac OS: 

Show/Hide Rulers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C+R

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . F7

J Keyboard Commands for Windows:

Show/Hide Rulers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . CTRL+R

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . F7

.1 Display Rulers and Guides: If rulers aren’t showing choose View & Show
Rulers. Rulers appear at the top and left of the document window.

If guides aren’t showing choose View & Show Guides. Margin Guides appear
around the edges of the document page.

.2 Create a horizontal guide: Click the Item tool e in the Tool palette. Move
the Arrow pointer a over the ruler at the top of the document window.

Click the ruler to display the g pointer and drag approximately 1.25" down the
document page (use the left ruler as a reference). When you release the mouse
button, a horizontal guide displays.

Nonprinting guides can be pulled from the rulers at the top and left of the document
page when the Show Guides command (View menu) is enabled.
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The Steps: Creating Guides

.4 Create a vertical guide: Move the Arrow pointer a over the ruler at the
left of the document window. 

Click the ruler to display the G pointer and drag approximately 3" across the
document page (use the top ruler as a reference). When you release the mouse
button, a vertical guide displays.

Ruler guides appear as green lines by default, but you can assign other colors to
them in the Display tab in the Application Preferences dialog box.

H Identifying guides: By default, on color monitors, margin guides are
displayed as blue lines and ruler guides are displayed as green lines.

QuarkXPress automatically places margin guides in all new documents. You
specify their position in the Margin Guides fields in the New Document
dialog box. Ruler guides are guides that you create by dragging them off the
horizontal and vertical rulers. 

H Displaying ruler guides: You can control whether ruler guides display
In Front or Behind QuarkXPress elements using the Guides menu in

the General tab of the Document Preferences dialog box.
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The Steps: Navigating through QuarkXPress

Navigating through QuarkXPress

The QuarkXPress document window functions like windows in most other
Mac OS and Windows applications. You move and resize document windows
as you would any other program’s windows. In this task you’ll learn to navi-
gate within a QuarkXPress window — within a page and from page to page.

J Keyboard Commands for Mac OS: 

Page Grabber Hand . . . . . . . . . . . . . . . . . . . . . . . . . . . .`
Go to Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+J

J Keyboard Commands for Windows:

Page Grabber Hand . . . . . . . . . . . . . . . . . . . . . . . . . . . .ALT

Go to Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+J

.1 Use the scroll bars to move the page around: Click the arrows on the
bottom and right sides of the document window, then try dragging the

box inside the scroll bars. 

This moves the page around. In documents with multiple pages, the scroll bars
let you navigate to other pages as well.

The arrows and boxes in the scroll bars allow you to move around within a page
or document.

.2 Use the Page Grabber Hand to move around within the page: Press
Option/ALT to display the Page Grabber Hand H. Move the mouse

around to move the page. 

.3 Locate the Go to Page dialog box: Choose Page & Go to. You can enter
page numbers in this dialog box to quickly jump to another page.

Since this document has only one page, click Cancel.
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.4 Locate the go-to-page pop-up menu: In the lower left corner of the docu-
ment window, locate the small triangle , (next to the far left scroll arrow). 

Click the arrow to display icons for the master pages and document pages.
Selecting a page icon displays that page in the document window.

The go-to-page pop-out menu provides a quick, visual method for switching pages
in a document.

H Switching pages in a document: The Document Layout palette
(View menu) displays an icon for each master page and document

page in a document. Double-clicking an icon displays that page in the
document window. As you become more familiar with QuarkXPress, you’ll
discover favorite keyboard commands that allow you to navigate between
pages as well.
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Working with Items

The distinction between “items” and “contents” is fundamental to QuarkXPress.
“Items” are text boxes, text paths, picture boxes, and lines. Text and picture-
related items support contents. “Contents” are text and pictures. Before you can
add text to a document, you must create a text box or a text path to contain it.
Before you can add pictures, you must create a picture box. To manipulate items,
you’ll usually need to select the Item tool e. In this task you’ll move and resize
an existing text box.

J Keyboard Commands for Mac OS:

Snap to Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .w+F7

J Keyboard Commands for Windows:

Snap to Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .SHIFT+F7

.1 Select the Item Tool e: If necessary, click the Item tool e in the
Tool palette.

.2 Select a text box: Click the text box on the pasteboard containing the
word “color.” When you click the text box, it becomes active — the border

becomes solid, and resizing handles appear at each corner and on each side.

A dotted outline depicts inactive boxes when guides are enabled (left). Active boxes
display solid borders and resizing handles (right).

For comparison with the text boxes above, this example shows an inactive picture
box (left) and an active picture box (right). 
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.3 Enable the Snap to Guides feature: Choose the View menu and make
sure a checkmark appears beside Snap to Guides. Because this command

“toggles” on and off, don’t highlight it if it is already checked.

.4 Move the “color” text box to the document page: Using the Item
tool e to drag the text box, align its upper left corner with the guides you

created earlier. As you drag the text box into position, it “snaps” to the guides.

The “color” text box is positioned on the document page.
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.5 Resize the text box: Move the Item tool e over the resizing handle on
the right side of the text box to display the Resizing pointer f.

Drag the resizing handle to the right margin guide. As you drag the handle, the
text box gets wider and its right side snaps to the margin guide.

The text box is extended to the right margin guide.

H Distinguishing text boxes from picture boxes: When Guides are show-
ing, an empty picture box can be distinguished from an empty text box

by the “X” pattern in the picture box.

H Switching between the Item and Content tool: To toggle between the
Item e and Content E tools press Shift+F8. When the Content

tool E is selected, you can select the Item tool e temporarily by pressing
C/CTRL.

H Snapping items to guides: The Snap to Guides feature helps you
quickly align items with ruler guides and page guides. When Snap to

Guides is checked and you drag an item within the snap distance, the item
seems to “jump” to the guide. The Snap Distance is specified in pixels in the
General tab of the Document Preferences dialog box.
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Modifying Items

The Modify dialog box lets you change several specifications for an active item
in a single dialog box. Like many menus, windows, and palettes in QuarkXPress,
the Modify dialog box is context-sensitive so its tabs vary depending on the
active item. In this task you’ll resize a text box using the Modify dialog box
instead of the Item tool e.

J Keyboard Commands for Mac OS:

Actual Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+1

Modify  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+M

J Keyboard Commands for Windows:

Actual Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+1

Modify  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+M

.1 Display the document at actual size: Choose View & Actual Size.
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.2 Open the Modify dialog box: If necessary, click to activate the text box,
then choose Item & Modify. 

Tabs in the Modify dialog box vary depending on the type of item that is active.
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.3 Change the height of the text box: Enter 2.5 in the Height field of
the Box tab, then click OK.

The height of the text box increases to 2.5".

H Navigating through fields: To highlight the next field in a palette or dia-
log box press the Tab key. To highlight the previous field, press Shift+Tab.

H Navigating through tabs: To display the next tab in a dialog box on
Mac OS, press C+Tab. To highlight the previous tab in a dialog box,

press C+Shift+Tab. To display the next tab in a dialog box on Windows, press
CTRL+TAB. To highlight the previous tab in a dialog box, press CTRL+SHIFT+TAB.
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Working with Contents

To manipulate contents, select the Content tool E. In this task you’ll use
the Content tool E to highlight text, then you’ll modify the text using com-
mands in the Style menu.

J Keyboard Commands for Mac OS:

Centered Alignment  . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+C

Other Size (font)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+\

J Keyboard Commands for Windows:

Centered Alignment  . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+C

Other Size (font)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SHIFT+\

.1 Select the Content tool E: Click the Content tool E in the Tool
palette.

.2 Change the text alignment: Click and drag the Content tool E over
the word “color” to highlight it, then choose Style & Alignment &

Centered.
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.3 Change the font size: Make sure the text is still highlighted, then choose
Style & Size & Other. The Character Attributes dialog box opens with

the Size field highlighted. 

From the Style menu you can choose preset font sizes in the Size submenu, or
choose Other to set font sizes manually in the Character Attributes dialog box.

Enter 150 in the Size field.

Click OK.
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Using the Measurements Palette

The Measurements palette lets you modify many item and content attributes.
Generally, the left side of the palette lets you modify items and the right side
lets you modify contents. In this task you’ll use the Measurements palette to
resize a picture box and modify the picture it contains.

J Keyboard Commands for Mac OS:

Show/Hide Measurements  . . . . . . . . . . . . . . . . . . . . . .F9

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . .F7

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+0 (zero)

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+W

J Keyboard Commands for Windows:

Show/Hide Measurements  . . . . . . . . . . . . . . . . . . . . . .F9

Show/Hide Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . .F7

Fit in Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+0 (zero)

Close  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+F4
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.1 Scroll to see the existing picture box containing an image of artists’
pastels: If necessary, click the horizontal scroll arrows to scroll across the

page or the vertical scroll arrows to scroll up or down the page.

The existing picture box is shown in the upper left corner of the document window. 

.2 Select the picture box: Using either the Item tool e or Content
tool E, click the picture box.

.3 If necessary, display the Measurements palette: Choose View &
Show Measurements.

Using the shaded bar at the left of the Measurements palette, drag it to a
convenient location such as the bottom of the screen. 
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.4 Resize the picture box: Using either the Item tool e or Content
tool E, click and drag the pointer over the value in the H field of

the Measurements palette to highlight it.

Enter 3.75, then press Return/ENTERr.

The H field reflects the height of the picture box.

.5 Resize the picture: Click and drag the pointer over the value in the X%
field (100%) on the right side of the Measurements palette to highlight it.

Enter 60 to scale the picture horizontally.

Press Tab to highlight the value in the Y% field (100%) on the right side of the
Measurements palette.

Enter 60 to scale the picture vertically.

Press Return/ENTERr.

The X% and Y% fields reflect the scale of the picture.

.6 Hide the document’s guides: Choose View & Hide Guides.

.7 Change the document view and deselect the picture box: Choose
View & Fit in Window, then click the pasteboard to see the results

of your changes.

.8 Close and save the document: Choose File & Close. If you haven’t
recently saved your document, a dialog box asks you to save it. Click Yes.

H Sizing and positioning items using the Measurements palette:
Items may be precisely sized or positioned by highlighting fields in

the Measurements palette, then entering desired values. To highlight a
field, click and drag the pointer over it or double-click the field.
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Checkpoint

Confirm your new skills — then try them out. If you have any questions, ask
your instructor or consult “The Details” section of this lesson.

How are you doing?

Make sure you can:

• Open an existing document

• Save a document

• Create and use guides

• Determine which tools are text-related and which are picture-related

• Determine which tools or menus you would use to manipulate items
or contents

• Manipulate items and contents using the Measurements palette

On your own

Experiment with new documents or open some of the other lesson files.
Try the following:

• Create a few more vertical and horizontal guides by dragging them off
the rulers.

• Move guides or drag them off the page — notice what happens in the
Measurements palette as you move guides.

• Try turning Snap to Guides (View menu) on and off, then move items
toward guides — notice the difference Snap to Guides makes.

• Select a text box that contains a lot of text and change the font size or
the alignment.

G The lesson files are all templates, which means you can open copies of
them without affecting the original files.
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Documents

QuarkXPress lets you create documents from scratch, build documents based
on existing templates, and work with previously saved documents. Documents
can consist of single pages or spreads with left- and right-facing pages.

Opening files

QuarkXPress allows you to have up to 25 documents, templates, or libraries
open at one time. Using the current version of QuarkXPress, you can open
documents saved in version 2.1 or later. To open a file, use the Open com-
mand in the File menu.

• If your document contains preference settings that are different from those in
your XPress Preferences file, the Nonmatching Preferences dialog box opens.
To use settings saved with the document, click Keep Document Settings. To
update the document to the XPress Preferences on your machine, click Use
XPress Preferences. Updating settings could cause text to reflow.

• If your document contains fonts not installed on your system, the Missing
Fonts dialog box displays. If you click Continue, QuarkXPress automatically
displays system fonts for the missing fonts. The fonts specified in the docu-
ment don’t change. To display a list of missing fonts, click List Fonts; then
you can choose other fonts to permanently replace them.

The pasteboard

The pasteboard is a nonprinting area that surrounds individual pages and
spreads. The pasteboard can be used as a work area, a temporary storage area,
or to “bleed” items off a page. The pasteboard works as follows:

• Scroll left or right to view the pasteboard. Create, position, or group items
on the pasteboard just as you would on a document page.

• To move an item from the pasteboard to a document page or another paste-
board, select the Item tool e, click the item; then drag it into position.

• When you create a horizontal ruler guide and release the g pointer over the
pasteboard, the guide displays across the pasteboard and all the pages in a
spread. If you release the g pointer over a document page, the guide displays
only on the page.

• Bleed is the term used to describe items that are printed to the edge of a finished
page. To create a bleed item, extend the item from a document page onto the
pasteboard. Once a document with bleed elements is reproduced on press, a
commercial printer can trim it to its finished page size. 
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Saving documents

The Save command records changes to your documents. When you choose
Revert to Saved, QuarkXPress discards the changes made since the last time
you saved. The Save as command lets you name and save a new document or
create a copy of an existing document. To use Save as: 

• Choose Save as (File menu). Use the controls in the dialog box to specify a
location for the new document file, then enter a name for the document in
the Save current document as field. 

• Choose a QuarkXPress file format version from the Version menu. Earlier
versions of QuarkXPress are unable to open documents saved in the current
version. Items based on features exclusive to the current version will be modi-
fied or stripped from documents saved in the 3.3 format.

• On Mac OS, check Include Preview to create a thumbnail preview of the
document for display in the Open dialog box; then click Save.

H Customizing the pasteboard width: To adjust the width of the paste-
board, click the Interactive tab of the Application Preferences dialog

box, then enter a value in the Pasteboard Width field. Pasteboard Width is
measured as a percentage of the document width. You can specify a value from
0% to 100%. At least .5" of pasteboard will always surround document pages
and the pasteboard width cannot exceed 48". The default width value is 100%.
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Tool Palette

The tools in the Tool palette are used to create and edit many elements in
QuarkXPress, including text boxes, picture boxes, lines, text paths, text, and pic-
tures. The tool you select determines which QuarkXPress commands are available. 

• To display the Tool palette, choose View & Show Tools. The Tool palette
remains open until you close it. To close the Tool palette, choose View &
Hide Tools or click the close box. 

• To select a tool, click it. Press C+Tab/CTRL+ALT+TAB to select the tool below
the current tool; press C+Shift+Tab/CTRL+ALT+SHIFT+TAB to select the tool
above the current tool. 

• To specify default settings for magnification and item creation through
the Tools tab of the Document Preferences dialog box, choose Edit &
Preferences & Document. You can also access the Tools tab by double-
clicking an item creation tool or the Zoom tool Z. Tool preferences apply
to the active document; if no documents are open, tool preferences become
application defaults.

J Keyboard Commands for Mac OS:

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Show/Hide individual tool  . . . . . . . . . . . . . . . . . . . . . .^+click

Select next tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+Tab

Select previous tool . . . . . . . . . . . . . . . . . . . . . . . . . . . .C+w+Tab

Keep tool selected  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .`+click

Page Grabber Hand H*  . . . . . . . . . . . . . . . . . . . . . . . .`
Zoom in pointer M . . . . . . . . . . . . . . . . . . . . . . . . . . . .^
Zoom out pointer m  . . . . . . . . . . . . . . . . . . . . . . . . . .`+^
*The Page Grabber Hand H is not accessible when the Zoom tool Z is selected
or when Caps Lock is enabled.
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J Keyboard Commands for Windows:

Show/Hide Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F8

Show/Hide individual tool  . . . . . . . . . . . . . . . . . . . . . .CTRL+click

Select next tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+TAB

Select previous tool . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+ALT+SHIFT+TAB

Keep tool selected  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .ALT+click

Page Grabber Hand H*  . . . . . . . . . . . . . . . . . . . . . . . .ALT

Zoom in pointer M . . . . . . . . . . . . . . . . . . . . . . . . . . . .CTRL+SPACE

Zoom out pointer m  . . . . . . . . . . . . . . . . . . . . . . . . . .ALT+CTRL+SPACE

*The Page Grabber Hand H is not accessible when the Zoom tool Z is selected.

Default Tool palette

The basic function of each tool in the Tool palette is described below: 

e Item tool selects, moves, resizes, and reshapes items (boxes, lines, text paths,
and groups), and reshapes clipping and runaround paths.

E Content tool imports and edits text and pictures, and imitates most Item
tool functionality.

R Rotation tool rotates items visually rather than numerically.

Z Zoom tool enlarges or reduces the document view.

T Rectangle Text Box tool creates a rectangular text box; provides access to
other text box tools. 

p, x, ç, ∂ Picture Box tools create a rectangle, rounded-corner, oval, or
Bézier picture box; the Rectangle Picture Box tool p provides access to other
picture box tools.

L Line tool creates straight lines of any angle; provides access to other line tools.

o Orthogonal Line tool creates perfectly horizontal or vertical straight lines.

Ò Line Text-Path tool creates a straight line of any angle, that supports text;
provides access to other text-path tools.

u Linking tool establishes text chains among text boxes or text paths.

U Unlinking tool breaks links among text boxes or text paths.

H Page Grabber Hand (not displayed in palette) scrolls a page in any direction.
To use, press Option/ALT — except when the Zoom tool Z is selected, and on
Mac OS when Caps Lock is enabled.
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Pop-out tools

Å, ı, Ç, Î, ´, Ô Text Box tools create a rounded-corner, concave-cor-
ner, beveled-corner, oval, Bézier, or freehand Bézier text box.

å, ∫, ƒ Picture Box tools create a concave-corner, beveled-corner, or freehand
Bézier picture box.

∞, § Line tools create a Bézier line or freehand Bézier line.

, Â, ˜ Text-Path tools create an orthogonal, Bézier, or freehand Bézier
text path.

Customizing the Tool palette

QuarkXPress lets you customize the Tool palette by rearranging, hiding, and
adding tools. Many tools are condensed under “pop-outs” indicated by a
triangular arrow on the tool icon.

• To display pop-out tools, click and hold a tool that has an arrow on its icon. 

• To select a pop-out tool and replace a tool on the main palette, click the tool
on the main palette and drag to the pop-out tool.

• To add a pop-out tool to the main palette, press Control/CTRL while you select
the tool from a pop-out.

• To hide a tool, press Control/CTRL while you click that tool. At least one tool
from each pop-out must remain on the main palette. 

• When you quit QuarkXPress, your current tool arrangement is saved in the
XPress Preferences file. The next time you launch QuarkXPress, your Tool
palette will be just as you left it.
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Item and Content Tools

When the Item tool e is selected, you can cut, copy, and paste picture boxes,
lines, text paths, and groups. When the Content tool E is selected, you
can cut, copy, paste, clear, and edit text or pictures.

Features specific to the Item tool e
When the Item tool is selected you can:

• Cut, copy, or paste active items entirely. (This is also possible when any other
tool is selected except the Content tool E.)

• Delete active Bézier points using the Delete/BACKSPACE key.

• Move active items using arrow keys.

• Activate a group by selecting only one of its items.

• Change the line attributes of an active text path. (This is also possible when
any other tool is selected except the Content tool E.)

Features specific to the Content tool E
When the Content tool is selected you can:

• Cut, copy, paste, or clear highlighted text or cut, copy, paste, or clear pictures
in active picture boxes. The boxes themselves are unaffected.

• Edit and apply attributes to existing text or import new text into an active text
box or text path.

I-beam pointer I
When the Content tool is over a selected text box or text path, the I-beam
pointer I displays. Click the I-beam pointer to place the Text Insertion bar i
where you want to import or edit text. You cannot place the Text Insertion bar i
below existing paragraphs. To highlight text, drag the I-beam pointer I over it. 

You can edit highlighted text using the Style menu, the Measurements palette,
keyboard commands, or the Text tab of the Modify dialog box (Item menu).

Text Insertion bar i
When you click the I-beam pointer I in a text box or path, a blinking Text
Insertion bar i displays. This is the text insertion point. If you create a new
text box, the Text Insertion bar i displays automatically at the top of the box.

You can enter text at the text insertion point by typing or choosing Get Text
(File menu). You can delete text preceding this point by pressing Delete/BACK-
SPACE. To reposition the Text Insertion bar i, use the arrow keys on the keyboard
or click with the I-beam pointer I. 
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Picture Mover pointer H
When the Content tool is over an active picture box that contains a picture, the
Picture Mover pointer H displays. To move the picture, drag the Picture Mover
pointer in any direction, or use the arrow keys on the keyboard.

You can edit a picture using the Style menu, the Measurements palette, key-
board commands, or the Picture tab of the Modify dialog box (Item menu).

Features common to the Item tool and the Content tool

You can use either the Item tool e or the Content tool E to:

• Select and manipulate boxes, lines, and text paths.

• Import and apply styles to pictures.

Arrow pointer a
When you select the Item or Content tool, the Arrow pointer a displays. To
select an item, click it with the Arrow pointer; to select multiple items, press
the Shift (w) key while you click them.

Marquee o
With either the Item or Content tool selected, you can access a standard
Marquee pointer o to select multiple items. Begin by pressing the mouse button
outside any item boundaries, then drag the Marquee over multiple items. To add
or remove an item, press the Shift (w) key while you click the item.

Resizing pointer #
When the Item e or Content E tool is over a bounding box handle of an
active item, the Resizing pointer # displays. To enlarge or reduce an item,
drag the handle using the Resizing pointer.

You can scale the contents of a box or text path, while you resize the item itself,
by pressing modifier keys as you drag a handle:

Mac OS
Resize item and scale contents Command

Scale C+drag
Scale and constrain to square bounding box C+w+drag
Scale and maintain proportions C+`+w+drag

Windows
Resize item and scale contents Command

Scale CTRL+drag
Scale and constrain to square bounding box CTRL+SHIFT+drag
Scale and maintain proportions CTRL+ALT+SHIFT+drag
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Mover pointer e
When the Item tool is placed over items, or Bézier items whose bounding box is
displayed, the Mover pointer e displays. To move active items, drag them using
the Mover pointer e. You can also press the Shift (w) key while selecting and
dragging an item to constrain its movement horizontally or vertically. To access
the Mover pointer e when the Content tool is selected, press C/CTRL.

G When you drag an item, only its outline displays. To see the item and its
contents, select Show Contents in the Interactive tab of the Application

Preferences dialog box (Edit menu), press the mouse button until the item
flashes, then begin dragging. To see item layering and text reflow as you move an
item, select Live Refresh in the Interactive tab, press the mouse button until the
multi-directional arrow pointer displays, then begin dragging.
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Rulers and Guides

Rulers and guides give you precise control for document layout. To ensure that
items are placed properly, you can “snap” items to guides. To display rulers,
choose View & Show Rulers. To display guides, choose View & Show Guides.
You can choose to display page guides either Behind or In Front of items using
the Guides menu in the General tab of the Document Preferences dialog box
(Edit menu).

Ruler guides

Ruler guides are guides that you create by dragging them off the horizontal and
vertical rulers. 

• If the Measurements palette is displayed when you drag a ruler guide, the
guide’s position is indicated in the X field (for vertical ruler guides) or the
Y field (for horizontal ruler guides). 

• If you release the mouse button when the g pointer is positioned over the
pasteboard, the ruler guide will extend across the pasteboard and all the pages
in the spread. If you release the mouse button when the pointer is positioned
over a document page, the ruler guide is displayed only on that page.

• To reposition a ruler guide, click it, then drag it to a different location using
either the g or the G pointer. You must have the Item tool e selected to click
and drag a guide when the pointer is over an item. To reposition a guide when
the pointer is over an item and the Content tool E is selected, press
C/CTRL while you click the guide and drag. 

• To remove a ruler guide, click it and drag it off the page. To remove ruler
guides from a spread’s pasteboard, scroll the document so that a portion of
the pasteboard is displayed; then press Option/ALT while you click the ruler
adjacent to the pasteboard. To remove ruler guides from a document page,
scroll the document so that a portion of the page is displayed; then press
Option/ALT while you click the ruler adjacent to the document page. Press
Option/ALT and click the horizontal ruler to delete horizontal ruler guides;
or click the vertical ruler to delete vertical ruler guides.

H Specifying preferences for rulers: Menus in the General tab of the
Document Preferences dialog box let you set preferences for rulers. You

can specify ruler measurement units using the Horizontal Measure and Vertical
Measure menus. The Item Coordinates menu lets you specify whether or not
the top ruler is continuous across multiple pages in a spread. Choose Spread to
display a single, continuous ruler across the top of pages in a spread. Choose
Page to repeat the horizontal ruler from 0 for each page in the spread. For exam-
ple, if you have a two page spread of letter size pages, the ruler will start at 0"
and end at 81⁄2" for each page.
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Menus and Dialog Boxes

There are seven basic menus available in QuarkXPress: File, Edit, Style, Item,
Page, View, and Utilities, plus the Window menu on Windows. The menu bar
can also display menus for help, and QuarkXTensions™ such as QuarkImmedia™

and QuarkDispatch™. Each menu contains groups of related commands separated
by lines. Many menu entries can be activated by keyboard shortcuts.

Context-sensitive menus

Menus are context-sensitive so menus or menu items can change according
to the active item, the current situation, or the tool selected.

• All the commands listed under a menu may change. For example, the
Style menu commands change depending on whether text, a picture, or a
line is active.

• An individual menu command may change. For example, the Undo command
in the Edit menu changes to reflect your last action (such as Undo Typing or
Undo Item Deletion).

• The availability of menu entries may change. For example, when a pic-
ture is selected, the Save Text command in the File menu is dimmed and
not available.

• The availability of entire menus may change. For example, the Style menu
entries for text are available only when a text box is active and the Content
tool E is selected.

Checkmark

A checkmark j in a menu indicates one of the following:

• A function has been performed. For example, a checkmark is displayed
next to Flip Vertical in the Style menu when the contents of a box are
flipped vertically.

• A feature is turned on. For example, a checkmark next to Snap to Guides in
the View menu means items in your document will snap to the guides.

• A format from a list has been applied. For example, a checkmark is displayed
in the Font submenu next to the font applied to selected text. When multi-
ple formats have been applied to a selection, checkmarks are displayed next
to formats common to the entire selection only. 

Dialog boxes

Dialog boxes contain related commands that let you specify exactly what you
want to happen. The context-sensitive controls in QuarkXPress dialog boxes
consist of tabs, areas, fields, menus, check boxes, and buttons.
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Tabs and areas
Many dialog boxes provide multiple functions through tabs. By clicking a tab,
you can display different sets of controls. Related commands within a dialog
box or tab are grouped into an “area,” surrounded by a border.

The Blend area of the Box tab in the Modify dialog box lets you specify a custom
blend for a box.

Lists
Some dialog boxes include lists of elements you can select or edit. For example,
the Colors dialog box (Edit menu) displays a list of colors. 
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Fields
A field is a rectangular box for entering a specific value. For example, in the
Text tab of the Modify dialog box (Item menu), you can enter the number of
columns for an active text box in the Columns field. When working with fields,
you can enter measurements in any of the QuarkXPress supported measurement
systems using the following abbreviations: 

Measurement System Abbreviation

inches or inches decimal "
picas p
points pt
millimeters mm
centimeters cm
ciceros c
agates ag

You can perform math in fields using these operators:

Function Operator

addition +
subtraction –
multiplication *
division /

For example, to double the width of a box, you can multiply the width by 2 by
entering *2 to the right of the current value. You can even perform multiple
operations — such as dividing a value by 4, then adding 2.

Menus (pop-up/drop-down) 
These are small menus within a dialog box or palette (usually called “pop-up
menus” on Mac OS and “drop-down lists” on Windows). A menu like this 
contains a list of options. A menu like this contains an editable field in
addition to a list of options. You can enter a value (such as a percentage) or a word
(like a font name) in the field, rather than choosing an option from the list.

Check boxes
A check box lets you turn options on and off . 

Buttons (radio/option) 
A button like this % lets you select from mutually exclusive options.
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Buttons
A button like this performs an action. If the button has a heavy
border , you can press Return/ENTERr rather than clicking the button
with the mouse. A button may also include a menu that lets you choose
a type of action. For example, the New button in the Style Sheets dialog box
(Edit menu) lets you create either a character style sheet or a paragraph style
sheet. Many dialog boxes in QuarkXPress include an Apply button so you can
preview your changes before closing the dialog box. 

G In certain dialog boxes such as Paragraph Attributes (Style menu) and
Character Attributes (Style menu), you can press Option/ALT the first
time you click Apply to continually preview changes as you make them.

H Using modifier keys with menus: The function of a menu command
may change slightly when you press a modifier key as you select the

menu. On Mac OS for example, if you press Option while you choose the Item
menu, the Send to Back command changes to Send Backward. 

H Selecting elements from a list: You can navigate through lists using the
up and down arrow keys. Depending on the type of list, you may be able

to multiple-select elements. To select a group of continuous elements, click the
first element then press the Shift (w) key while clicking the last element in the
range. To select a group of noncontinuous elements, press C/CTRL while clicking
each element.

H Specifying units of measure: You only need to specify an abbreviation
for units of measure when you are not using the default measurement

system. The default measurement system is specified in the Horizontal Measure
and Vertical Measure menus in the General tab of the Document Preferences
dialog box (Edit menu).

H Performing math in fields: When performing calculations in fields,
QuarkXPress performs multiplication and division first, followed by

subtraction and addition, from left to right. You cannot use parentheses when
performing math in fields. 
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Measurements Palette

The Measurements palette lets you quickly edit several commonly used item
specifications. Options on the Measurements palette change to reflect the
currently selected tool or item. The left side of the palette indicates an item’s
position; the right side indicates an item’s content.

Overview

You can edit any of the values in the Measurements palette. Changes made
to values on the left side of the palette are applied when you exit the palette;
changes made to numerical values on the right side of the palette are applied
when you move to a different field or exit the palette. Clicking a button or
choosing an item from a menu on the right side of the Measurements palette
applies the change immediately.

Measurements displayed in the Measurements palette are updated when you
create, move, resize, or modify items, create or move guides, or reposition the
ruler origin.

Measurements palette for text boxes

Item information
When a text box is selected, the left side of the Measurements palette lets
you view and edit the text box item information. 

• The X and Y fields indicate the horizontal and vertical locations of the origin
(upper left corner) of the text box.

• The W and H fields indicate the width and height of the text box.

• The r field indicates the text box’s angle of rotation.

• The Cols field indicates the number of columns in the text box.

Content information
When the Content tool E is selected, the right side of the Measurements
palette lets you edit the contents of the text box.

• The ( button lets you flip the contents of the text box along a horizontal axis.

• The ) button lets you flip the contents of the text box along a vertical axis.

• The n field indicates paragraph leading. Enter a value in the field or click the
arrows to adjust leading.
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• The N field indicates kerning when the Text Insertion bar i is between
two characters and indicates tracking when a block of text is highlighted.
Enter a value in the field or click the arrows to adjust kerning and tracking.

• The {, }, [, $, ] buttons indicate left, centered, right, justified, and forced
justified alignment of selected paragraphs.

• The Font menu < indicates the selected font. To change the font, choose a
font from the menu or enter the name of the font in the field.

• The Size menu < indicates the size of the selected font. To change the font
size, choose a size from the menu or enter a value in the field.

• The P, B, I, U, W, ?, O, S, K, H, +, _, and M buttons indicate plain, bold,
italics, underline, word underline, strike thru, outline, shadow, all caps, small
caps, superscript, subscript, and superior type styles, respectively. Multiple
type styles may be applied to a single character or group of characters.

Measurements palette for picture boxes

Item information
When a picture box is selected in the document window, the left side of the
Measurements palette lets you edit the picture box item information.

• The X and Y fields indicate the location of the origin (upper left corner) of
the picture box.

• The W and H fields indicate the width and height of the picture box.

• The r field indicates the picture box’s angle of rotation.

• The = field indicates the radii of the corners of the picture box.

Content information
When the Content tool E is selected, the right side of the Measurements
palette lets you edit the contents of the picture box.

• The ( button lets you flip the contents of the picture box along a
horizontal axis.

• The ) button lets you flip the contents of the picture box along a vertical axis.

• The X% and Y% fields indicate the horizontal and vertical scaling of the
contents of the picture box.
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• The N and n fields indicate the horizontal and vertical offsets of the contents
of the picture box from the picture box’s origin (upper left corner).

• The r field indicates the angle of rotation of the contents of the picture box.

• The S field indicates the skew (slant) of the contents of the picture box.

Measurements palette for lines

When lines are active, fields displayed on the left side of the Measurements
palette vary according to the line description method selected in the Mode
menu. Line description methods let you choose whether to describe the selected
line by its Endpoints; its First Point, length, and angle; its Last Point, length,
and angle; or by its Midpoint, length, and angle. 

Fields on the right side of the Measurements palette indicate the following
line information:

• The W field indicates the width of a selected line.

• The left menu indicates the line’s style.

• The right menu indicates the line’s arrowheads.

Fields on the left side of the palette vary (according to Mode) as follows:

Endpoints

• The X1 and Y1 fields indicate the horizontal and vertical coordinates of the
first endpoint of the line.

• The X2 and Y2 fields indicate the horizontal and vertical coordinates of the
last endpoint of the line.

First Point

• The X1 and Y1 fields indicate the horizontal and vertical coordinates of the
first point created for the line.

• The r field indicates the line’s angle of rotation.

• The L field indicates the line’s length.

40



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 1: The Concepts

The Details: Measurements Palette

Midpoint

• The XC and YC fields indicate the horizontal and vertical coordinates of the
midpoint (middle) of the line.

• The r field indicates the line’s angle of rotation.

• The L field indicates the line’s length.

Last Point

• The X2 and Y2 fields indicate the horizontal and vertical coordinates of the
last point created for the line.

• The r field indicates the line’s angle of rotation.

• The L field indicates the line’s length.

Measurements palette for groups and multiple-selected items

When groups of items or multiple items are selected, the Measurements palette
lets you edit the origin, dimensions, and angle of the group of items.

• The X and Y fields indicate the location of the origin (upper left corner) of
the bounding box containing the group of items.

• The W and H fields indicate the width and height of the bounding box
containing the group of items.

• The r field indicates the angle of rotation of the group of items. When an
item is rotated with a group of items, it is rotated relative to the center of the
bounding box enclosing the group, not to its own origin (upper left corner).

41



QuarkEd for QuarkXPress Module 1: QuarkXPress Fundamentals

Lesson 1: The Concepts

The Details: Measurements Palette

Measurements palette for editing Bézier items

When a point, line segment, or curve handle on a Bézier shape is selected, the
Measurements palette lets you edit the origin, dimensions, and angle of the
item, as well as the type of point or line segment in the shape. You can also
enter values to manipulate point position and curve handle angle and length.

• The X and Y fields indicate the horizontal and vertical locations of the origin
(upper left corner) of the Bézier item’s bounding box.

• The W and H fields indicate the width and height of the Bézier item.

• The r field indicates the angle of rotation of the Bézier item.

• The Symmetrical Point button † lets you convert a point into a symmetrical
point for a Bézier item.

• The Smooth Point button ¥ lets you convert a point into a smooth point for
a Bézier item.

• The Corner Point button ® lets you convert a point into a corner point for
a Bézier item.

• The Straight Segment button œ lets you convert a curved line segment to a
straight line segment for a Bézier item.

• The Curved Segment button ∑ lets you convert a straight line segment to a
curved line segment for a Bézier item.

• The XP and YP fields indicate the horizontal and vertical location of the
active point.

• The Diamond Curve Handle Angle field r indicates the angle of the dia-
mond-shaped curve handle in relation to the active point.

• The Diamond Curve Handle Distance field „ indicates the distance of the
diamond-shaped curve handle from the active point.

• The Square Curve Handle Angle field r indicates the angle of the square-
shaped curve handle in relation to the active point.

• The Square Curve Handle Distance field Œ indicates the distance of the square-
shaped curve handle from the active point.

H Accessing fields in the Measurements palette: To access fields in the
Measurements palette, click them. To access the first field in the palette,

press C+Option+M (Mac OS) or CTRL+ALT+M (Windows). Press Tab to highlight
the next field, or press Shift+Tab to highlight the previous field. Click the docu-
ment, or press Return/ENTERr to apply changes made in the Measurements
palette. On Mac OS, press C+period (.) to exit the palette without applying
changes. On Windows, press ESC to exit the palette without applying changes.
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H Using the Measurements palette with anchored text boxes: When
an anchored text box is active, the Measurements palette indicates

whether the text box aligns with the ascent 6 or baseline 5 of the associated
line of text. Click the ascent 6 or baseline 5 buttons to change the align-
ment of an anchored text box. When the Content tool E is selected, the
Measurements palette displays the same content controls for anchored text
boxes as those for nonanchored text boxes. The X, Y, and r fields are not
available for anchored text boxes.

H Using the Measurements palette with anchored picture boxes: When
an anchored picture box is active, the Measurements palette indicates

whether the picture box aligns with the ascent 6 or the baseline 5 of the
associated line of text. Click the ascent 6 or baseline 5 buttons to change
the alignment of the anchored picture box. When the Content tool E is
selected, the Measurements palette displays the same content controls for
anchored picture boxes as those for nonanchored picture boxes. The X, Y, r,
and = fields are not available for anchored picture boxes.
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